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Introducing WordPerfect® Office X3

WordPerfect® Office X3 is everything you'd expect from an office suite — and
more — for less. Enhanced compatibility ensures that you can work with people
who use Microsoft® Office or other office suites. Each application in the suite
has been updated with stylish new buttons and toolbars to provide more
familiar and easy-to-use environments. With lightning speed, the new
WordPerfect® MAIL™ application will find information in the most cluttered
inbox. Plus, groundbreaking new features and enhancements, such as
PDF-import capability, make this the most enticing and innovative WordPerfect
Office yet.

It's Compatible

WordPerfect Office continues to break down compatibility barriers for its users.
These days, who has time to figure out which product works with which file
format? Customers want to simply and easily open, edit, save, and send
documents, spreadsheets, and slide shows. To that end, WordPerfect Office X3
provides improved support for Microsoft Office file formats. In addition, the
suite’s built-in PDF publishing capabilities have been enhanced, making it easier
than ever to exchange information.

It's Easy to Use

WordPerfect Office X3 provides exciting new features that are designed to
reduce the need for software expertise. The user interface (Ul) for each
application has been refreshed, providing more intuitive, familiar environments.
Context-sensitive toolbars make it easy to identify tools and features. You can
copy HTML and paste clean, unformatted text. The unmatched Corel® RealTime
Preview™ |ets you see how potential formatting changes will affect your work
before you commit to them. To help new users find their footing, the Workspace
Manager can simulate the keystrokes and menu items of other office suites, such
as Microsoft Office. The unobtrusive PerfectExpert™ is a handy guide and
consultant for virtually any project. Plus, two free hours of training videos by
lynda.com are included on CD.
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It's Feature-rich

WordPerfect Office X3 offers an outstanding collection of rich features that help
you get the job done. As the world’s only office suite that can import PDF files
without requiring additional software or expense, WordPerfect Office X3 makes
it easier than ever to repurpose content. A new Count button has been added to
the application bar, so the Word Count feature is now always just a click away. In
addition, the WordPerfect® OfficeReady™ template browser makes it simple to
find the perfect template for any project.

The recently introduced WordPerfect MAIL combines e-mail, calendar, and
contact management tools with stellar spam protection, innovative filing
capabilities, and ultra-fast search. To streamline workflow, the integrated
Presentations™ Graphics X3 makes it easy to create, edit, and reuse original
drawings and pictures in WordPerfect®, Quattro Pro®, Presentations™, and
elsewhere. You also get quick, integrated access to Web search functionality
and a variety of other online resources with the new WordPerfect® Online
Resources featuring Yahoo!® Search.

It's Affordable

At less than half the cost of Microsoft Office, WordPerfect Office X3 ensures that
you're getting the best value for your dollar. Corel’s flexible licensing options
have recently won over high-profile customers, such as the United States
Department of Justice, the Canadian Government, and the United States Courts.
In addition, free technical support is available 24 hours a day, seven days a week,
with the online Corel® Knowledge Base™, which contains answers to commonly
asked technical questions.

It Makes Perfect Sense

Renowned for its unique and innovative features, its enthusiastic and loyal user
base, and its 20-year reputation for delivering professional results, WordPerfect
Office is the world’s number-one alternative to Microsoft Office. It makes perfect
sense. In today’s market, customers are weary of rising costs and the expectation
of an exclusive commitment to a single vendor. WordPerfect Office X3 addresses
this concern and differentiates itself by delivering exceptional customer value. It
combines the features and capabilities that office-suite users expect with
outstanding ease of use, true flexibility, and an unparalleled ability for content
reuse. WordPerfect Office X3 has solutions designed specifically for government
offices, law firms, schools, businesses, and even home offices.
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WordPerfect® Office X3 Customer Profiles

WordPerfect Office X3 has been designed specifically for six key customer
segments, each with distinct characteristics and needs. To indicate which
features are most applicable to which customer segment, the following segment
icons have been used throughout this reviewer’s guide.

WQLMDO

Please note that each icon denotes the segment for which a feature is most
applicable. The benefits of the features described, however, are not limited to
those segments.

Government

Public sector organizations, ranging from dozens to thousands of seats, require
low-cost, enterprise-class features, Microsoft Office compatibility, an open
architecture, support for open standards, ease of use, and accessibility.

Legal

Legal professionals and entities, ranging from small firms and solo practitioners
to large firms and legal aid groups, require advanced formatting, robust PDF
capabilities, legal-specific tools, and support for key file formats, such as
WordPerfect, Microsoft Office, PDF, and EDGAR®.

Consumer

Customers shopping for their home PCs seek feature-rich and easy-to-use
software to help them with a wide variety of tasks, including general
correspondence, home-based business projects, home office projects, school
assignments, family budgets, and work projects.
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Small Business

Cost-conscious, small- or home-based businesses, typically with fewer than 50
PC-using employees and without a complex IT infrastructure, require software
that allows professional-looking content to be created quickly.

Education

Education customers, ranging from individual students and teachers to schools
and other educational institutions of all sizes, share the need for low cost,
flexible licensing, Microsoft Office compatibility, and a user interface (Ul) similiar
to that of Microsoft Office. Corel extends education pricing to not-for-profit
organizations of all sizes.

Enterprise

Private sector organizations, ranging from hundreds to thousands of seats, seek
a low total cost of ownership (TCO) alternative to Microsoft Office. Enterprises
need feature-rich, easy-to-use software, enterprise-class deployment and
network installation tools, Microsoft Office compatibility, an open architecture,
open standards support, regularly updated service packs, professional services,
training, and customization options.
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What's Included with
WordPerfect® Office X3 — Standard Edition?

Main Applications

WordPerfect® X3: This powerful word-processing application provides
capabilities that simplify your work. Easy to use and highly compatible with
Microsoft® Word, WordPerfect X3 provides all the tools needed to create
dynamic documents that are easily shared with other computer users.

Quattro Pro® X3: Featuring enhanced compatibility with Microsoft® Excel,
this powerful spreadsheet application can help you organize, analyze,
report, manage, and share important data and financial information.
Quattro Pro X3 provides easy-to-use charting features and advanced
rendering options that give your information a professional, polished look.

Presentations™ X3: With enhanced compatibility with Microsoft®
PowerPoint®, Presentations X3 includes all the tools you need to create slide
shows, project proposals, interactive reports and demonstrations,
multimedia presentations, flyers, signs, banners, and more. For easy sharing,
you can publish projects to HTML or Macromedia Flash™. Plus, the
self-contained presentations technology, Show On The Go™, lets any PC user
view your project — whether or not they use Presentations.

WordPerfect® MAIL™: With lightning speed, WordPerfect MAIL finds
information buried by years of inbox, contact, or calendar clutter. In addition
to e-mail, calendar, and contact management, this full-featured, easy-to-use
application includes innovative filing capabilities and outstanding spam
protection.

Presentations™ Graphics X3: For years, this easy-to-use graphics tool has
been tightly integrated with WordPerfect Office. Now easier to access than
ever before, you can choose Presentations Graphics X3 from the Start menu
to create and edit original drawings and pictures. With support for many
commonly used file formats, Presentations Graphics X3 ensures that you can
reuse your graphics with other products.

Supporting Utilities

WordPerfect® OfficeReady™ Template Browser: This template browser
makes it easy to find the right template for any project. It provides
thumbnail views of available templates that open with a single click.

WordPerfect OFFICE X3
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¢ WordPerfect® Office Conversion Utility: The WordPerfect® Office
Conversion Utility makes it easy to convert batches of any document type
that WordPerfect can open. For example, you can convert an entire folder
structure of Microsoft Word documents to WordPerfect.

¢ PerfectScript™: PerfectScript™ was developed specifically for WordPerfect
Office applications to help you create macros, recordings, and scripts.

¢ QuickFinder™: QuickFinder™ is a powerful utility that lets you find files by
performing highly customizable searches.

e Pleading Expert: The Pleading Expert is a step-by-step wizard that helps
you create pleading cover sheets. It guides you through page, margin, font,
line, footer, and signature settings, and lets you save pleading styles that you
can easily reuse.

Additional Applications in the Professional Edition

¢ Paradox®: A relational, file-based database application, Paradox® lets you
store and retrieve data in a variety of ways. To help you track, organize, and
compile data, this complete desktop database solution stores information in
powerful, searchable tables.

¢ Microsoft® Visual Basic® for Applications: Microsoft® Visual Basic® for
Applications lets developers build custom business solutions by automating
and integrating off-the-shelf software applications to meet specific customer
needs.

¢ Software Developer Kit (SDK): With the Professional Edition, an SDK is
included to simplify deployment and maintenance of the software.

Additional Resources in the Professional Edition

¢ WordPerfect® Office X3 Deployment Guide: Included as a PDF file, this
step-by-step resource simplifies network deployment.

¢ WordPerfect® Office X3 Programming Guide for VBA: Included as a
PDF file, this new manual is a resource for developing and distributing
Microsoft Visual Basic for Applications solutions.

¢ Deploying Macros and Templates: Included as a PDF file, this guide
provides helpful information on sharing macros and templates with other
WordPerfect Office X3 users.

Content
¢ WordPerfect Office X3 includes 9,500 clipart images, 175 photos, and 900
TrueType fonts.

Documentation

¢ Help files now provide Zoom In and Zoom Out buttons so that you can
adjust the display size.

e PerfectExpert™
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e Printed 256-page user guide
(Retail version of WordPerfect Office X3 — Standard Edition)

e The user guide is also included as a PDF.

Minimum System Requirements

e  Windows® XP (Home or Professional Edition with latest Service Pack),
Windows 2000 (with latest Service Pack), or Windows 98 SE

e 128 MB of RAM (256 MB recommended)

e 466-MHz processor (Pentium® IIl or equivalent processor recommended)
e 575 MB of hard disk space for minimum installation

e Super VGA, 16-bit color monitor with 800 x 600 or greater resolution

e CD-ROM drive

e Mouse or tablet

¢ Microsoft® Internet Explorer 5.5 or later version

Installation

The installation wizard makes it easy to install WordPerfect Office X3.

To install the software

1 Insert Disc #1 into your CD-ROM drive.
The WordPerfect Office X3 CD1 screen appears.

2 Select the WordPerfect Office X3 option to install the software, and
follow the instructions on your screen.
A message is displayed when installation is complete.

3 Click Finish to exit the installation wizard.
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Summary of New and Enhanced Features

Suite-wide

Built-in publish to PDF capabilities make it easy and cost-effective to
share WordPerfect Office documents while maintaining control over content
and appearance.

With WordPerfect, Quattro Pro, and Presentations, it's easy to exchange
information with Microsoft® Office users thanks to enhanced
compatibility with Microsoft Office file formats.

Easier to use thanks to a more familiar, intuitive environment with newly
updated, stylish buttons and toolbars that now support Windows® XP
default themes.

The enhanced PerfectExpert™ provides easy access to an array of project
templates and, if asked, provides helpful advice for virtually any project.

Enhanced multilingual character support ensures that extended
characters display accurately.

Finding the right template has never been easier with the enhanced
WordPerfect® OfficeReady™ template browser.

The enhanced Migration Manager makes it easy to retain settings from a
previous WordPerfect Office installation.

Now accessible from the Start menu, Presentations™ Graphics X3 is
tightly integrated with WordPerfect®, Quattro Pro®, and Presentations™.

Enjoy e-mail, calendar, contact, spam protection, and lightning-fast search
capabilities with the new WordPerfect® MAIL™.,

With WordPerfect Office X3 — Professional Edition only, take advantage of
the enhanced Paradox® — a relational desktop database application.

WordPerfect® X3

The new ability to Import PDF files with WordPerfect® X3 makes it easy
to reuse text and graphics from PDF files without additional purchase.

The enhanced Publish To PDF feature now converts WordPerfect
table-of-contents headings into PDF bookmarks for easy PDF navigation.

WordPerfect OFFICE X3
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e Access online resources and quickly conduct Web searches with the new
WordPerfect® Online Resources featuring Yahoo!® Search.

e Gain more control and quickly access the enhanced Word Count feature by
using the new Count button on the application bar.

¢ Enhanced Document Routing makes it easy to collect feedback from
multiple collaborators.

¢ Enhanced integration with WordPerfect® MAIL™ makes it easy to share
a WordPerfect MAIL address book with WordPerfect for creating routing
slips to use for document routing.

e Easily repurpose HTML content with the enhanced Paste Without
Formatting feature.

¢ Now, you can view and print WordPerfect documents from a Web browser.

¢ Quickly and easily remove confidential or sensitive information from
documents with the new Save Without Metadata feature.

¢ New label formats are available from industry-leading suppliers.

Quattro Pro® X3

e Share spreadsheets and charts with any computer user who has Adobe®
Reader® software, thanks to the new Publish To PDF feature.

e Create polished, professional-looking reports with the enhanced CrossTab
reports, which now maintain connections with ODBC databases.

e Easily apply advanced rendering to charts with enhanced charting tools.

Presentations™ X3

¢ The enhanced Publish To PDF feature now translates slide names into PDF
bookmarks for easy PDF navigation of presentations and slide shows.

¢ Use a new Master from the enhanced Master Gallery to create
professional-looking slide shows and presentations without having to design
from scratch.

e Show off presentations with smoother, more rounded text and images,
thanks to enhanced anti-aliasing and graphics interpolation.
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Top New and Distinguishing Features

PE
NI W
D8

PE
NI W
<L

Suite-wide

Renowned for the freedom that it affords you to work in whichever manner you
choose, WordPerfect Office continues to provide more options and flexibility in
how you get the job done. The often imitated, yet still unrivaled, Reveal Codes
feature eliminates document formatting problems. In addition, the exceptional
Corel RealTime Preview lets you see exactly how potential formatting changes
will look before applying them.

To reduce the learning curve and training costs, the Workspace Manager can
help new users become familiar with WordPerfect Office. You can set the
applications to simulate the keystrokes and menu items of other office
productivity applications, including Microsoft Office. In addition to these
popular benefits, WordPerfect Office X3 has been dramatically updated with a
wide variety of innovations, including groundbreaking built-in PDF import and
export capabilities.

New & Enhanced! Share your documents as PDFs: WordPerfect Office
X3 makes it easy to share information with other computer users. Whether it's a
spreadsheet, drawing, slide show, or HTML Web page, the now suite-wide
Publish to PDF feature lets you convert any document to PDF.

Since 1999, WordPerfect Office has offered the most robust PDF publishing
capabilities of any office suite. Quattro Pro X3 now provides the same PDF
publishing feature offered by WordPerfect and Presentations. In addition, the
PDF capabilities of WordPerfect and Presentations have been enhanced. To learn
more about these enhancements, please consult their respective descriptions on
pages 15 and 22.

Enhanced! Compatibility with Microsoft® Office: Do you need to
communicate with friends, clients, or colleagues in Microsoft Office file formats?
Not a problem. You can open, edit, and create all current Microsoft Office files.
Out of the box, WordPerfect even lets you open more legacy Microsoft Word
formats than Word 2003 allows. When working in Microsoft Office mode, you
can also easily set your WordPerfect Office X3 applications to save as Microsoft
Word (DOC), Microsoft Excel (XLS), or Microsoft PowerPoint (PPT) by default.

WordPerfect OFFICE X3
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Compatibility for text alignment and table borders have been enhanced with
WordPerfect X3 so that they are imported more accurately from Microsoft Word.
Plus, support for automatic paragraph numbering has been improved. For
Quattro Pro X3, support for comments within the Excel spreadsheet and support
for cell formatting in Excel 2000 exports have been improved. Based on direct
user feedback, Presentations X3 now supports backgrounds, footers, layouts and
masters, data charts, and object transformation (rotating, moving, scaling, and
skewing).

In addition, WordPerfect, Quattro Pro, and Presentations each include a
Compatibility toolbar that makes it easy to save in multiple formats, including
Microsoft Office formats, PDF, HTML, and XML. To further ease the transition for
newer users, the Compatibility toolbars also include one-click access to Help
topics that address working with Microsoft Office files.

The Compatibility toolbar

New from project: Click
this button to create a
new document based on a
project template.

icrosoft® Word Help: Click
this button to access Help
about working with Microsoft
Word files and environments.

Compatibility

IETLEE

Save as Microsoft®
el bm"m" © \-\ruhllsh to HTML: Click this
?otmnmrgdpieuamft button to publish the
Word format. document to HTML format for
use on the Web.
WordPerfect® Office Publish to PDF: Click this button

Conversion Utility: Click to publish the document to PDF Publish to XML: Click this
this button to convert format so that it can be viewed button to publish the
documents in other file by any computer user that has document to XML format.
formats to WordPerfect. Adobe® Reader® installed

Works like Microsoft® Office: Are you familiar with Microsoft Office?
Concerned about having to learn another office suite? With WordPerfect Office
X3, there's no need to hunt for commands or features, or figure out new
keystrokes. With a single click, the unique Workspace Manager automatically
adopts the keystrokes and menus of the software with which you're most
familiar — whether it's WordPerfect Office, Microsoft Office, or Lotus 1-2-3.

New! Updated User Interface: The first thing you'll notice about
WordPerfect Office X3 is the clean, new look. With support for Windows XP
default themes, the toolbars, dialog boxes, and controls of WordPerfect,
Quattro Pro, and Presentations have been updated. This familiar appearance
helps new users more quickly discover new features and capabilities. You can
also easily change these options to suit the look that most appeals to you.
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PerfectExpert™: Get started quickly with the PerfectExpert, a step-by-step
guide that offers an array of project templates and helpful advice. Positioned on
the left side of the workspace, this comprehensive resource waits unobtrusively
to provide help when you need it. When you start a PerfectExpert project, the
PerfectExpert panel dynamically updates to provide advice and guidance specific
to the task at hand.

Using the PerfectExpert™ to create a letter

1 Start WordPerfect X3, and click the PerfectExpert # button.

2 In the PerfectExpert panel, click Start » New Project / Existing
Document.

3 In the PerfectExpert dialog box, click the Create New tab, choose
Standard Letter from the list box, and click Create.
The Standard Letter template opens, and the PerfectExpert panel
changes to provide help for the task at hand.

4 Use the options in the PerfectExpert panel to add content to your
letter and to adjust its formatting.

Enhanced! Support for International Fonts: Enhanced support for
international fonts makes it easier for WordPerfect Office to create content in
multiple languages and exchange information with other multilingual products,
such as Microsoft Office. This means that international language characters
display and print accurately, and it positions WordPerfect Office for growth in
such markets as Europe, Africa, and more.

Enhanced! WordPerfect® OfficeReady™ browser: Crucial for the ease
of use of any office suite, templates provide guidance for document formatting
and structure while letting you focus on content. With WordPerfect Office X3,
searching for the right template couldn’t be easier. Hit the ground running by
exploring the WordPerfect OfficeReady browser for thumbnail views of
available templates. Simply click on the one that best suits your needs.

Enhanced! Corel® Migration Manager™: Upgrading from previous
WordPerfect Office installations has never been easier, thanks to the enhanced
Corel® Migration Manager™. Designed to save time for network deployments
and large-scale installations, you can easily retain macros, templates, and other
custom settings. In addition, you can import WordPerfect Office 12, WordPerfect
Office 11, or WordPerfect Office 2002 settings and files. Alternatively, IT
managers can customize a command line to migrate settings from a previous
installation.

Home and Laptop Licensing: Here's a prime example of the value and
flexibility that WordPerfect Office provides. Corel recognizes that the line
between home and work has become less defined. To that end, the purchase of
WordPerfect Office X3 allows for an additional installation on a home computer
or laptop — free of charge.

WordPerfect OFFICE X3
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WordPerfect® X3

WordPerfect X3 provides exceptional ease of use and complete formatting
control for producing newsletters, articles, reports, proposals, books, and other
documents. The popular Reveal Codes, Corel RealTime Preview, and Legal
features help reduce the amount of time you spend on document formatting,
freeing you to focus on creating content. WordPerfect X3 also provides
enhanced compatibility with Microsoft Word, the new ability to import PDFs,
and robust PDF publishing capabilities, ensuring that you can freely exchange
information with colleagues and clients, regardless of the software they use.
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WordPerfect Office X3 features a stylish, updated user interface.

New! Import PDF files with WordPerfect®: WordPerfect X3 is the only
office suite with built-in capabilities for importing, editing, and publishing PDF
files. No other office suite can make this claim. With half a billion installations of
Adobe® Reader® worldwide — the free viewer for the ubiquitous file format —
computer users rely on PDF to exchange information.

Too often customers have difficulties when trying to access and reuse PDF
content. To resolve this challenge, WordPerfect X3 introduces the ability to
import PDF files. By simply opening a PDF with WordPerfect X3, you can easily
reuse text and graphics, and then save the file to any of the various formats
offered, such as XML, DOC, WPD, PDF, HTML, and more.

Adobe Acrobat PDF

1> Wordperfect X3 f‘l:::": ’

many other formats

WordPerfect X3 lets users import, edit, and save PDF files.
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Importing a PDF file

1 Click File » Open.

2 Choose the drive and folder in which the PDF is stored, select the file,
and click Open.
If the PDF is protected by a password, type the password in the
Password box.

3 You can now edit the document’s content, formatting, and graphics.
To save your changes, click the Save button.

4 In the Save File dialog box, type a name for the document in the File
name box, choose a format from the File type list box, and click
Save.

Enhanced! Publish To PDF: Since 1999, WordPerfect has provided the most
robust PDF publishing capabilities of any office suite, preserving the layout and
formatting of the original document. Requiring no purchase of additional
plug-ins or downloads, the Publish To PDF feature ensures that you can share
your WordPerfect documents with virtually any computer user. With
WordPerfect X3, the Publish To PDF feature has been enhanced to translate
WordPerfect table-of-contents headings into PDF bookmarks. This makes it easy
to navigate the PDF when it's opened with Adobe Reader.

o2BER a
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WordPerfect X3 lets users publish documents to PDF.

Publishing a WordPerfect document to PDF

1 Click View P Toolbars, and enable the Compatibility option in the
list of available toolbars.

2 On the Compatibility toolbar, click the PDF (@@ button.

3 On the General tab, click Browse. Choose the drive and folder in
which you want to save the file, type a filename in the Filename box,
and then click Save.

WordPerfect OFFICE X3
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4 From the PDF style list box, choose one of the following options:

¢ Smallest file — Creates a PDF that is intended for online viewing
(for example, a document distributed by e-mail or displayed on the
World Wide Web).

e Standard desktop printing and viewing — Creates a PDF that is
intended for viewing or printing on a laser or desktop printer.

¢ Highest quality — Creates a high-quality PDF that is intended for
sending to a printer or a digital copier.

5 Click OK.

New! WordPerfect® Online Resources featuring Yahoo!® Search:
The new WordPerfect Online Resources featuring Yahoo!® Search provides
access to Web tools that are integrated with WordPerfect X3. With a single click,
you can access frequently updated tips and tricks, learning tools, and other
WordPerfect Office resources. You can also access informative Yahoo! sites that
feature news, finance, and educational materials.

Providing tight integration between WordPerfect and the Web, the Yahoo!
search functionality lets you right-click words in your WordPerfect documents to
search the Web. You can hide or display the WordPerfect Online Resources with
a single click. In addition, you have the option to install the WordPerfect —
Yahoo! Internet Explorer toolbar, so your favorite online resources, including
tips and tricks, tutorials, video how-to’s, special offers, and partner information,
are never far from reach.
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The new WordPerfect Online Resources provide quick Web search functionality and
access to important information online.

Performing a Web search by using WordPerfect® Online
Resources

1 Click the Show / Hide Yahoo! Search ? button to display the
Yahoo! Search bar.

2 Inthe search box, type the term that you want to search.

3 Click the Search Web button.

New & Enhanced! Word Count: The new Count button on the application
bar makes the Word Count feature easier to access. You can click this button
anytime to update the active document’s word count. In addition, the Word
Count feature has been enhanced to give you more control over which
document elements to include in the count. For example, you can choose to
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include or exclude headers, footers, comments, footnotes, endnotes,
watermarks, text boxes, and box captions.

Bl [¥AB & <count> | Insert | Pg1Ln1"Pos1.12"

The new Count button appears on the application bar, making word count
functionality easier to access than ever before.

Counting words in a document

1 Click Tools » Word Count.

2 To exclude document elements from the count, disable any of the
following check boxes, and click OK.

Headers
Footers
Comments
Footnotes
Endnotes
Watermarks
Textboxes
Box captions

3 To refresh the word count at any time, click the Count button on the
application bar.

m PéTe \ Enhanced! Document Routing: You can save time while collaborating with
J colleagues by gathering feedback through Document Routing. With

WordPerfect X3, you can use the recently introduced WordPerfect MAIL to send

your document to multiple users. Each user adds comments and sends the
document to the next name on the routing slip; a single document containing all
feedback returns to you. For flexibility, document routing also works with other
e-mail applications, such as Microsoft® Outlook®.

Creating a routing slip for document routing

1 Click File » Document » Routing Slip.

2 Type asubject name in the Subject box.
The subject name appears in the subject box of the e-mail to be sent.

3 Type a message in the Message box.
This text appears in the message area of the e-mail to be sent.

4 Click Addresses to add reviewers to the Reviewers list box.
The WordPerfect or Outlook address book opens

5 When you have added the reviewers’ e-mail addresses, click OK.

6 To send the document for review, click File » Document P Send to
Reviewer.

7 When your default e-mail application opens, click Send.

WordPerfect OFFICE X3 Reviewer’s Guide [ 17 ]



Enhanced! Integration with WordPerfect® MAIL™: WordPerfect allows
you to use your WordPerfect MAIL address book in WordPerfect. For example,
you can choose an individual from the WordPerfect MAIL contact list when
creating routing slips for document tracking or creating envelopes and labels.

Using a WordPerfect® MAIL™ address book with
WordPerfect®

1 In WordPerfect X3, click Tools » Address Book.

The Address Book dialog box opens.

2 Inthe tree view, click the plus sign (+) beside WordPerfect Mail, and
choose an address book.

Enhanced! Pasting and exporting HTML: The Web is a critical source of
content. Experience shows that customers need to be able to repurpose Web
content more easily with their office suite. To that end, WordPerfect X3
introduces the new Paste Unformatted Text command, which you can access by
using the right-click menu, or the Ctrl + Alt + V keyboard shortcut. The ability to
capture HTML content and reuse it unhindered by formatting problems saves
significant time. In addition to providing an easy-to-use menu, the Publish to
HTML dialog box now offers a Plain HTML option for exporting HTML.

New! View in Web browser: By user request, WordPerfect X3 provides
convenient integration with Microsoft Internet Explorer, so that you can more
easily work with WordPerfect files from a Web browser. If you have WordPerfect
X3 installed, you can easily open current and legacy WordPerfect documents
within a browser for viewing and printing. This integration also extends to such
products as Microsoft® Sharepoint® and IBM® Workplace™.

New! Removing metadata: WordPerfect X3 helps ensure that you'll never
get caught with confidential or sensitive information in your documents. Every
few months, the media reports a case of metadata exposing a document'’s
secrets. Metadata is information that lurks within office productivity files, such
as undo/redo history, reviewers’ notes, hidden text, and comments. This type of
information is often confidential, and its inclusion within files could be
detrimental to court cases or contract negotiations. The new Save Without
Metadata feature makes it simple to remove all metadata from your documents
— without requiring additional purchase or download.
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The new Save Without Metadata dialog box makes it easy to remove metadata from
your documents.

Saving a WordPerfect® X3 document without metadata

1 Click File » Save Without Metadata.

2 Enable the Keep Original Document Open check box.

If this check box is not enabled, the original document will close, and
the metadata-free version will remain open.

3 Choose the drive and folder in which you want to save the document.

By default, _mtd is added to the filename to identify that the file does
not contain metadata.

4 In the Select Metadata To Remove area, enable any of the
following check boxes:
¢ Comment Information
Hidden Text
Annotations
Undo/Redo History
Document Summary Data
Headers
Footers
Hyperlinks
OLE Object Information
Routing Slip

5 C(lick Save.

New! Label formats: WordPerfect Office X3 provides new label formats
from well-known brands, such as Avery® (in letter and A4 formats), C-Line Label
Products®, and Wilson-Jones®.

Reveal Codes: This unique feature has long been a favorite of WordPerfect
aficionados because it helps to reduce the time required for formatting your
document. Easy to use, Reveal Codes makes it simple to change document
formatting. For example, to remove bold formatting, you can turn on Reveal
Codes, locate the <Bold> code, and then just drag it out of the Reveal Codes

WordPerfect OFFICE X3
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window. You can also double-click any code in the Reveal Codes window to
make advanced alterations to the settings or styles.

Pleading Expert and Legal toolbar: The Pleading Expert is another
example of WordPerfect providing customization options to fit every need. With
the Pleading Expert, you create a custom pleading format — one time, and for
each variation required — and then simply use the Pleading Expert Filler to
complete your pleadings.

To save time, help you get organized, and streamline your workflow, you can
turn on the Legal toolbar. It provides quick access to tools that let you easily
create Tables of Authorities, Tables of Contents, and lined Pleading Paper. Other
tools on the Legal toolbar let you turn on automatic paragraph numbering, use
Redlining, create watermarks, publish to EDGAR, and compare documents.

Quattro Pro® X3

Quattro Pro X3 is a powerful spreadsheet application that helps you organize,
analyze, report, manage, and share important data and financial information.
Improved compatibility with Microsoft Excel ensures that you can smoothly
exchange information with Excel users. Quattro Pro X3 also includes outstanding
tools for creating tables, financial forms, lists, databases, charts, reports, or any
other type of data-oriented document. In addition, you can easily present your
spreadsheet data in charts, and you can apply advanced rendering to your charts
to give the information a professional, polished look.

OSEBs AD Ao HEHNE AT REA G ¢
= “BRIY ™ Coms v Bl We v e
Shent £ @
A B C o 3 F G H I 4 L3 L L
5
& Detobar 31 Octobar 31 Octobar 31
7 2004
B
5 Assats
10 Cumant azsets
n Cash 3 WEET 5 10,55 5 5567
12 Rmyiricind canh 300 115 1,831
13 Srort fem evestments ] [ 6,188
H ACCoorts receable 15,704 |7 12,687
15 Frventory 565 1238 3
15 Frepads 1633 1378 1244
7 Total current assets 39469 E=RI] 7,830
18
9 Irvestmeres i 653 4
X Cagial assts 2975 346 4,899
n Intangiie avsets 26,410 5170 46,515
z Goodwil 10,833 10543 8,584
= Deferrea inancing charges T 2075 578
24 Total assets 3 107,498 3 10T 438
r3
L. L}
I Lisbities and snareholders’ squiry
E] CurTert Haciites
] Accoorts payable and Moo lsciites  § 17358 § 25540 5 17
= Cpsratre e of crecit o 2500 u *
3 Current porbion of kag-ferm ioan 4281 nme 2619 &l
] Fiome tues payatin 5940 6550 6163 s
T e ETETF IS TR ik sl i 3
4BE Compary b ChickCal e AL

Quattro Pro X3 features a stylish, updated user interface.

New! Publish To PDF: Now, you can easily share your spreadsheets and
charts by using the ubiquitous PDF file format. Quattro Pro X3 includes the same
robust PDF publishing capabilities offered by WordPerfect and Presentations.
When you publish to PDF, anyone who has the free Adobe Reader software can
view your Quattro Pro X3 files. In addition, you can specify a page range when
publishing to PDF, which is useful for exporting only portions of a spreadsheet.
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Publishing a Quattro Pro® spreadsheet to PDF

1 Click View » Toolbars, enable the Compatibility option in the list of
available toolbars, and click OK.

2 On the Compatibility toolbar, click the PDF [z button.

3 On the General tab, click Browse. Choose the drive and folder in
which you want to save the file, type a filename in the Filename box,
and click Save.

4 In the Export range area, enable one of the following options:
¢ Notebook
e Current Sheet
¢ Selection
If you choose Selection, the Publish to PDF dialog box is minimized so
that you can make a selection of cells with the cursor. When you've
made a selection, press Enter.

5 From the PDF style list box, choose one of the following options:
¢ Smallest file — Creates a PDF that is intended for online viewing
(for example, a document distributed by e-mail or displayed on the
World Wide Web).
¢ Standard desktop printing and viewing — Creates a PDF that is
intended for viewing or printing on a laser or desktop printer.
¢ Highest quality — Creates a high-quality PDF that is intended for
sending to a printer or a digital copier.

6 If necessary, specify a page range in the Pages from and to list boxes.

Click OK.

Enhanced! CrossTab Reports: You can easily create a CrossTab report
(known as a PivotTable in Excel) with Quattro Pro X3. Simply drag and drop to
create custom CrossTab Reports. In addition, business- and enterprise-class
customers can now access and refresh a connection, by way of Open Database
Connectivity (ODBC), between Quattro Pro and their database of choice, such as
Paradox or SQL.

Charting tools: Quattro Pro X3 includes enhanced charting tools that help you
project a professional image and ensure that your charts are exactly as you want
them. You can quickly and easily select a chart type, set its position, and adjust
3D depth — anything you need to properly display your data. In addition, tight
integration with WordPerfect Office X3 puts these easy-to-use charting tools at
your fingertips from both WordPerfect and Presentations.

WordPerfect OFFICE X3
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Presentations™ X3

Presentations X3 includes all the tools you need to produce slide shows, project
proposals, interactive reports and demonstrations, multimedia presentations,
flyers, signs, banners, and more. Presentations X3 provides enhanced
compatiblity with Microsoft PowerPoint and enhanced PDF publishing
capabilities. In addition, Show On The Go™ lets any PC user view your
presentation — even those who don’t have Presentations installed on their
computer.
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Presentations X3 features a stylish, updated user interface.

Enhanced! Publish To PDF: Since 1999, Presentations has provided users
with robust PDF publishing capabilities that preserve the layout and formatting
of the original document. Requiring no purchase of additional plug-ins or
downloads, the Publish To PDF feature ensures that you can share your
Presentations slide shows with virtually any computer user in the world. With
Presentations X3, the Publish To PDF feature has been enhanced to translate
slide names into PDF bookmarks. This makes it easy to navigate the PDF file
when it's opened with Adobe Reader.

Giveita try

Publishing a Presentations™ slide show to PDF

On the toolbar, click the PDF @ button.

2 On the General tab, click Browse. Choose the drive and folder where
you want to save the file, type a filename in the Filename box, and
then click Save.

3 Inthe Export range area, enable one of the following options:
Full document

Current view

Selection

Slides

Speaker notes

Audience notes

Handouts

If you choose Slides, adjust the value in the Range box.
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Give it a try

4 From the PDF style list box, choose one of the following options:
¢ Smallest file — Creates a PDF file that is intended for online
viewing (for example, a document distributed by e-mail or displayed
on the World Wide Web).
¢ Standard desktop printing and viewing — Creates a PDF file
that is intended for viewing or printing on a laser or desktop printer.
¢ Highest quality — Creates a high-quality PDF file that is intended
for sending to a printer or a digital copier.

5 Click OK.

Enhanced! Master Gallery: The Master Gallery now includes newly created
Masters on which you can base your presentation or slide show. These new
Masters save time by helping you achieve the right look without having to
design from scratch each time. Simply start Presentations X3, scroll through the
available backgrounds, and click the one that best suits your needs. It's never
been easier to ensure that your slide show or multimedia presentation will be a
hit!

Enhanced! Anti-aliasing: Presentations X3 provides enhanced anti-aliasing
and graphics interpolation to ensure that your multimedia presentations are of
the highest possible quality. As specifically requested by customers,
Presentations X3 provides cleaner, smoother, rounded fonts and images during
editing and playback of slide shows.

Presentations™ Graphics X3

Presentations Graphics X3 is an easy-to-use graphics application that includes a
broad range of bitmap-editing tools and special effects. For years, WordPerfect
Office users have enjoyed the benefits of ths tightly integrated drawing tool,
which is now accessible from the Start menu. You can use Presentations Graphics
X3 to create, edit, and enhance original drawings and pictures for use with
WordPerfect, Quattro Pro, Presentations, on the Web, or elsewhere.
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Presentations Graphics X3 lets you create and edit original drawings and pictures.
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Layout tools: Presentations Graphics X3 provides layout tools that help you
easily position objects in your drawings. There are guides and a customizable
grid, both with convenient snap-to functionality. You can also turn on the ruler
and add horizontal or vertical guides by simply dragging them from the ruler. In
addition, there are tools for changing object order and position, as well as for
aligning, flipping, rotating, combining, grouping, and separating objects.

Shape tools: Presentations Graphics X3 contains a wealth of shape tools to
ensure that you'll never run out of creative options. You can choose from line,
polyline, polygon, curve, ellipse, Bézier, and freehand lines. There are also plenty
of tools for creating basic, arrow, flowchart, star, callout, and action shapes — all
of which you can easily resize to suit your projects. In addition, Presentations
Graphics X3 gives you easy-to-use chart and organization chart tools.

Color, Texture, and Shading tools: Adding color, textures, and shading to
objects is simple with Presentations Graphics X3. For foreground or background
colors, you can choose from RGB, CMYK, or HLS color models. You can also easily
adjust line and outline color and choose from pattern, gradient, texture, and
image fills that are easy to customize. Changing an object’s brightness or
contrast is straightforward, and you can even transform color objects or pictures
to varying degrees of black-and-white. In addition, the Image Fill tool lets you
quickly create watermarks, transparencies, silhouettes, outlines, grayscale
images, and more.

Creating a drawing with Presentations™ Graphics X3

1 From the Start menu, choose Programs » WordPerfect Office X3 »
Presentations Graphics X3.

2 Click View ) Ruler.
Horizontal and vertical rulers surround the drawing window.

3 Click View ) Grid / Guides / Snap » Display Grid.
A grid displays in the drawing window, making it easier to position
objects.

4 C(lick View » Grid / Guides / Snap » Snap to Grid.
As you position objects, they snap to the grid.

5 From the toolbox, click the Basic Shapes [~ flyout, choose a shape,
and drag in the drawing window to create the shape.

6 From the toolbox, click the Fill Pattern | - flyout, and choose a
pattern.

7 From the toolbar, click the Rotation Options =~ flyout, and choose
a rotation angle.

As you can see, Presentations Graphics X3 provides an array of options
for creating drawings. Experiment with the options in the toolbox and
toolbar to achieve the result you want.

[ 24 ] Reviewer's Guide

WordPerfect OFFICE X3



Trace tool: With a single click, Presentations Graphics X3 lets you quickly
convert bitmaps to vectors.

Scrapbook™: The Scrapbook™ lets you browse through a selection of clipart
images and photos that you can use to enhance your drawings, presentations,
slide shows, or documents.

Bitmap editor: Presentations Graphics X3 includes a bitmap editor that lets
you create and edit bitmap images. The bitmap editor includes paintbrush,
airbrush, eraser, flood fill, and pickup-color tools. You can easily adjust the size
and shape of these tools with a single click.

Special effects: The bitmap editor offers a variety of customizable special
effects that you can add to bitmaps. You can apply the following special effects
to enhance an entire bitmap or a specific area that you have selected: Blur,
Brightness, Contrast, Emboss, Equalize, Mosaic, Rain, Saturation, Sharpen,
Smooth, Spike Removal, Stereogram, Trace Contours, and Wind.

Sharing your drawings: You can save drawings created or enhanced with
Presentations Graphics X3 in various file formats, such as WordPerfect graphic,
Windows bitmap, JPEG, and GIF. These flexible options ensure that you can easily
share your drawings with colleagues and clients. You can also reuse your
drawings for other WordPerfect Office projects.

Editing a graphic in WordPerfect®, Quattro Pro®, or
Presentations™

1 In WordPerfect X3, Quattro Pro X3, or Presentations X3, click Insert »
Graphics » From File.

2 In the Insert Image dialog box, browse to locate the graphic you want
to use, click Insert, and then click to position the graphic on the page.

3 Double-click the graphic.
Presentations Graphics X3 opens the graphic for editing.

4 Make any changes you want to the graphic, and click the Close 2
button.
Your changes to the graphic are saved, and you are returned to the
original application.
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WordPerfect® MAIL™

With lightning speed, WordPerfect MAIL finds information buried by years of
inbox, contact, and calendar clutter. This new addition to the WordPerfect Office
family is a full-featured, easy-to-use application that provides e-mail, calendar,
and contact management. Without the complexity of Outlook, you can easily
use WordPerfect MAIL to connect to mail services from an Internet Service
Provider (ISP).

WordPerfect MAIL also provides innovative filing capabilities and outstanding
spam protection to help you keep your inbox clean and tidy. In addition,
WordPerfect MAIL offers automatic features to manage mailing lists,
distribution lists, and RSS (Really Simple Syndication) news feeds. Plus, you can
feel secure knowing that they are avoiding viruses targeted at Outlook.
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One-click search: WordPerfect MAIL provides Quick Search buttons that
instantly find and sort all messages by a particular sender, or all messages within
a subject. For example, to find a specific message from within a thread of
messages, simply select any message from the thread and click the Quick Search
button to view all related messages.

= Subject: Welcome to WordPerfect Mail Status:

Brom:  “wiordPerfect Mail Team" <wordperfectprodmarSicarel, conm: 1ead ¥
Date:  ‘wed, Junr15-2005 8:23 AM
To News 'wordPerfect Mail User

The WordPerfect MAIL Quick Search buttons let you instantly view all messages from
a particular e-mail address or about a particular subject.

Using one-click search

1 Inthe Message List pane, select the message you want to use as the
basis for your search.
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In the Preview pane, click the magnifying glass icon next to the

Subject field to search for all messages that contain the same words in
the Subject line, or click the magnifying glass next to the From field to
search for all messages that contain the sender's name.

The search results of either search appear in the Message List pane,
with the number of messages that met the search criteria appearing in

the title bar.

Smart Groups for RSS feeds: With WordPerfect MAIL, you can use Smart
Groups to manage subscriptions to RSS (Really Simple Syndication) feeds and
online mailing or distribution lists, such as news, reports, and other information
that is updated on a daily, weekly, or monthly basis. Smart Groups automatically
moves messages from the inbox to specified folders. RSS feeds, such as CNN.com,
Wired News, the Motley Fool®, and others, provide an advantage over standard
mailing or distribution lists since you do not have to give an e-mail address to
the provider.

The Smart Groups wizard makes it simple to manage subscriptions to RSS feeds and

Smart Groups Wizard 3]

Select from popular RSS Feeds or create your own.

US News

Financial News

reaking news fiom CBS Marketi'stch.

rsonal Finance News:

ersonal Finance news from CBS Markebatch,

<Back Cancel

online mailing or distribution lists.

Adding an RSS Feed Smart Group

1
2
3

Click Configure » Smart Groups, and click Add.
Enable the RSS feed option, and click Next.

Scroll down to the Custom RSS feed area, and type a name in the
Enter subscription title box.

You can use whatever title you want. The name you choose appears
under Smart Groups in the Navigation pane and in the Configuration
dialog box.

Type the RSS URL in the Enter RSS feed URL box.

If you want to include a description of the RSS feed, type the
description in the Enter description box.

Click Next, select one of the Lifecycle options, and click Finish.

If you choose the Create a custom lifecycle option, the Smart
Groups message lifecycle dialog box opens. You then need to specify
lifecycle settings and click Accept changes.

WordPerfect OFFICE X3

Reviewer’'s Guide [ 27 ]




Spam protection: To protect you from junk e-mail, or spam, WordPerfect
MAIL includes SAproxy Pro, the most comprehensive anti-spam software
available today. With a five-point protection system to fight spam, SAproxy Pro
learns from stored e-mail, uses a whitelist and blacklist system to filter incoming
e-mail, uses rules to scan incoming e-mail, consults with community blacklists,
and calculates historical averages of received e-mail. You can train SAproxy Pro
to recognize which messages you consider spam and which ones you consider
legitimate. This powerful feature remains effective even as spammers change
their tactics for finding your inbox.
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WordPerfect MAIL includes SAproxy Pro, which uses a five-point protection system to
help keep your inbox free of spam.

Paradox®

Paradox is included only with the Professional edition of WordPerfect Office X3.
A relational, file-based database application, Paradox lets you store and retrieve
data in a variety of ways. To help you track, organize, and compile data, this
complete desktop database solution stores information in powerful, searchable
tables. Each table can hold more than 2 GB of information. In addition, Paradox
includes Web functionality, an easy-to-use interface and a number of interactive
tools. It also lets you publish data in various file formats, such as Quattro Pro
(QPW), Microsoft Excel (XLS), Lotus 1-2-3, and dBASE® (DBF).

Enhanced! Paradox® updates since version 10: Paradox can now
connect to external databases by way of ODBC DSN, using Windows XP Service
Pack 2. Quattro Pro tables are now easily imported into Paradox, and DDE-
related operations within Paradox work more smoothly.
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Comparing WordPerfect® Office X3 Editions

WordPerfect® Office X3 - Standard Edition

WordPerfect Office X3 — Standard Edition includes the trusted power of
WordPerfect X3 for word processing, Quattro Pro X3 for spreadsheets and
charts, Presentations X3 for multimedia slide shows, WordPerfect MAIL for
communication, and Presentations Graphics X3 for creating and editing original
drawings and bitmaps. In addition, the Pocket Oxford™ English Dictionary, Legal
tools, and the WordPerfect OfficeReady template browser are included. Highly
compatible, it's the world’s number-one alternative to Microsoft Office.

WordPerfect® Office X3 - Professional Edition

WordPerfect Office X3 — Professional Edition is ideal for customers who need
advanced database functionality, or who have complex or customized
installations. It includes everything in the Standard Edition, except for
WordPerfect MAIL. It also includes Paradox for relational databases, Microsoft
Visual Basic for Applications, and a Software Developer Kit (SDK). In addition,
the Professional Edition includes a network deployment guide, a template and
macro guide, and a VBA programming guide. The openness of the WordPerfect
file format makes it easy for vendors to open and create WPD files. It's also easy
to create custom Dynamic Link Libraries (DLLs) to automate and integrate
applications with WordPerfect Office.

WordPerfect® Office X3 - Student and Teacher Edition

An A+ alternative to higher-priced products, WordPerfect Office X3 — Student
and Teacher Edition is perfect for students and educators alike. Licensed for
noncommercial use, it includes WordPerfect X3 for word processing, Quattro Pro
X3 for spreadsheets, Presentations X3 for multimedia slide shows, Paradox for
relational databases, and Presentations Graphics X3 for bitmap graphics
creation. Plus, the Pocket Oxford English Dictionary and the WordPerfect
OfficeReady template browser are included. In addition, the Student and
Teacher Edition is licensed for use on up to three PCs per single household.

WordPerfect OFFICE X3

Reviewer’'s Guide [ 29 ]



WordPerfect® Office X3 - Home Edition

Designed with the specific needs of home computer users in mind, WordPerfect
Office X3 — Home Edition provides eight leading home PC tools in one complete
package. It includes WordPerfect X3 — Home Edition for word processing,
Quattro Pro X3 - Home Edition for spreadsheets and charts, two WordPerfect
OfficeReady template collections, Corel® Photo Album™ 6 — Standard Edition
for managing digital photo collections, Pinnacle Studio™ SE for editing home
videos, Pinnacle Instant CD/DVD LE v8 for burning CDs and DVDs, and Norton
Internet Security™ 2006 for protection from viruses and other threats. This
compatible, feature-rich, value-packed suite is sure to make your entire
household’s computing experience more enjoyable, creative, and secure.

WordPerfect® Office 12 - Small Business Edition

WordPerfect Office 12 — Small Business Edition lets users invest time and money
back into their businesses. With the trusted power of WordPerfect, Quattro Pro,
and Presentations, users can create impressive brochures, slide shows, and other
marketing collateral. Paint Shop Pro helps users ensure that their imagery is
optimized, and antivirus and firewall applications protect sensitive information.
The Pocket Oxford English Dictionary and the WordPerfect OfficeReady
template browser are also included. In addition, users can stay in touch with
WordPerfect MAIL.

For more information on the differences between WordPerfect Office X3
editions, please see Appendix A.
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Additional Services and Resources from Corel
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Corel® Customer Support Services

Free support: Available 24 hours a day, 7 days a week, 365 days a year, the
Corel Knowledge Base provides free and unlimited support for all registered
users of Corel’s retail and licensed software. This searchable Web-based tool
provides answers to commonly asked technical questions. Responses are
searchable in seven languages, including English, French, German, Italian,
Spanish, Portuguese, and Japanese. To search the Corel Knowledge Base, please
visit: www.corel.com/knowledgebase.

Premium support: Corel’s highest level of technical support is designed for
corporate clients who require account management services and access to
Corel's most skilled support personnel. When you register for Premium Services,
you choose the number of support incidents you wish to have in your Base
Package — available in sets of 10, 25, 50, and 200, or contact-based. All base
packages include e-mail support, toll-free telephone support, access to online
support history, service account management, and Corel personnel assigned to
ensure that your organization’s technical support needs are met.

Corel's experienced support team can also assist you with:

e Product Integration

¢ Open Document Management (ODMA)
¢ Network Configuration

¢ Product Deployment

¢ Color Management

e File Conversion

* Prepress Support

e Scripting and Macro Troubleshooting

¢ Technical Training
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Corel® Professional Services™

The Corel® Professional Services™ team builds solutions for international
market leaders in government and Fortune 1000 organizations, including
aerospace, defense, manufacturing, utilities, retail, and financial services.

Corel Professional Services team members possess experience and expertise from
years of application rollouts, pilot project programs, and 3rd-party integrations.
For help in understanding best practices in implementing Corel technologies,
Professional Services offers a range of services specially designed for the
individual needs of our customers, including

e Application Automation and Integration Support
e Software Deployments

e Solution Sets

e Training

Call 1-877-864-7446 to find out how Corel Professional Services can help your
organization.

Enhanced! Software Developer Kit

With WordPerfect Office X3 — Professional Edition, a software developer kit
(SDK) is included to simplify deployment and maintenance. The SDK is a valuable
resource for developers, integrators, and IT departments working with custom
installations, as well as for users who want to unlock the power of PerfectScript.
The SDK includes open WordPerfect file format specifications, making it easy to
create custom DLLs for integration and deployment purposes.

The SDK also includes documentation on migrating existing projects, a macro
command history, and WPLOOK.exe — a tool for internal viewing and
troubleshooting of WordPerfect files.

Additional Resources in the Professional Edition

WordPerfect Office X3 - Professional Edition includes an application deployment
guide, a macro and template deployment guide, and a VBA programming guide
as PDF files.

Enhanced! WordPerfect® Office X3 Deployment Guide: Revised and
expanded for WordPerfect Office X3, this step-by-step resource simplifies
network deployment. It contains detailed instructions for creating a server
image, building command lines, and pushing or pulling installations to
workstations, as well as frequently asked questions and a glossary of terms.

New! Deploying Macros and Templates: New for WordPerfect Office X3,
this guide provides helpful information on sharing macros and templates with
other WordPerfect Office X3 users. It also provides procedures for migrating
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macros, templates, and customized user settings from previous versions of
WordPerfect Office.

New! WordPerfect® Office X3 Programming Guide for VBA: New for
WordPerfect Office X3, this manual is a resource for developing and distributing
Microsoft Visual Basic for Applications (VBA) solutions. It provides detailed
instructions for creating, running, debugging, providing a user interface, for
organizing and deploying macros created with VBA. The guide also includes a
glossary of terms.

WordPerfect® Expert Newsletter

The WordPerfect® Expert is where you'll find everything you need to keep up-
to-date with what's happening in WordPerfect world: including news and
events, tips, tricks, and training opportunities. Also included are some free
downloads — just for the WordPerfect community. To subscribe, visit
www.wordperfect.com/newsletter.

WordPerfect® Office Learning Resources

In addition to the WordPerfect Office X3 User Guide and Help systems, there are
many additional resources designed to help you get the most out of this
powerful, feature-rich office suite. Corel has partnered with several leading
training and publishing organizations to bring you a wealth of valuable product
information. Whether you're a beginning or advanced WordPerfect user, there
are many fantastic resources available to help you. To learn more, visit
www.wordperfect.com/learning.

Automation Marketplace

The Automation Marketplace is a one-stop shop for tools that extend the
functionality of WordPerfect Office. It features tools developed by various Corel
technology partners, such as Gavel and Gown Software, Inc., PCLaw, Chesapeake
Interlink, Ltd., and Pentaware. To find out if the Automation Marketplace has a
tool that could help your company, you can visit: www.wordperfect.com/
automationmarketplace.
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Appendix A: Comparison of WordPerfect® Office X3 Editions

This table illustrates the differences between the Standard, Professional, Student and Teacher, and
Home editions of WordPerfect Office X3.

® ®
WordPerfect® WEEL OIS BRIl RS WordPerfect®
" Office X3 - Office X3 - )
Office X3 - . Office X3 - Home
Standard Edition iz ST I Edition
Edition Teacher Edition
WordPerfect® X3 v v v WordPerfect X3 -
Home Edition
Quattro Pro® X3 v v v Quattro Pro X3 -
Home Edition
Presentations™ X3 v v v
WordPerfect® v Trial Trial Trial
MAIL™ (English only) (English only) (English only) (English only)
WordPerfect® v v v v
OfficeReady™ . .
Browsery (English only) (English only) (English only) (English only)
Paradox® v v
Software Developer v
Kit
Microsoft® Visual v
Basic® for
Applications 6.3
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About Corel

Corel Corporation provides innovative software solutions that help millions of value-conscious businesses
and consumers in more than 75 countries improve their productivity. The company is renowned for its
powerful software portfolio, which combines innovative photo-editing, graphics-creation, vector-
illustration, and technical-graphics applications with office and personal productivity solutions. Corel’s
flagship products include CoreDRAW® Graphics Suite, WordPerfect® Office suite, Corel® Paint Shop
Pro®, Corel® Painter™, and Corel DESIGNER® Technical Suite. For more information, please visit
www.corel.com.
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